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ACCESSING THE “SMART” APPLICATION

Microsoft Edge is the preferred browser for all SNPLMA-related tasks. Google Chrome is acceptable but
may occasionally have display issues. While the data will still be present, formatting may not align
perfectly, which could affect readability.

Currently, there are two methods of user authentication for accessing SMART. Both methods require your
email address for verification. Thus, it is crucial that SNPLMA has your exact email address linked to
your SMART account.

1) DOI Users — Active Directory Federation Services (AFDS): This method is used if you are
logged in through the Department of The Interior (DOI) network. Your login credentials will
be authenticated using the ADFS system, which connects to the DOI network.

2) Non-DOI Users — Login.gov: If you are not on the DOI network, SMART will utilize
login.gov for user authentication. This must be a work email address in order for access to be
granted.

If you are teleworking, ensure you are connected to your network via VPN to use ADFS. This connection
is necessary for authentication to succeed when you are working remotely.

SMART should be accessed through the SNPLMA Website located here: SNPLMA | Bureau of Land
Management (blm.gov)

Once you successfully log in to SMART, you will generally be directed to the Main Screen automatically.
Below are the details of what to expect upon logging in and a brief overview of the main screen’s layout.

=== P2 T |
g’ SNPLMA Management And Reporting Tool 6

- - - s P e S T e bl e A e g ey T
Input: FY 2025 Qtr 1 / Status Input: FY 2024 Qir 3 Project  Reports  Logout v A e e

Projects [collapse]

Capital Improvemants WeLcoME To SNPLMA MANAGEMENT AND REPORTING TooOL

Conservation Initiatives

Environmentally Sensitive
Land Acquisitions

Hazardous Fuels Reduction
Plans and Wildfire
Prevention Projects
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https://www.blm.gov/programs/lands-and-realty/regional-information/nevada/snplma
https://www.blm.gov/programs/lands-and-realty/regional-information/nevada/snplma

If you have been assigned multiple roles or belong to several distribution groups within the SMART
system, you will be presented with a role selection screen upon logging in. This feature allows you to
select the appropriate role that fits your current responsibilities, ensuring access to the necessary functions
and data relevant to your tasks (e.g., Sysadmin, Program Manager, Entity, Program Manager (Read Only)
role, etc.).

ACCOUNT SELECTION

mmm
ACKD dackerman@blm.gov Select
ACKDEB dackerman@blm.gov Yes Select
ACKREADE dackerman@blm.gov  Yes Select
DACKERMAN dackerman@blm.gov  No Select
DEBSNAP dackerman@blm.gov  No Select
PMDMA dackerman@blm.gov  No Select
SMART Main Screen

Upon successful login to the SMART system, the first screen you will encounter is the Welcome Screen.

v, S |
SNPLMA Management And Reporting Tool ﬁ

Capital Improvements

Conservation Initiatives

Environmentally Sensitive
Land Acquisiticns

Hazardous Fuels Reduction
Plans and Wildfire
Prevention Projects

At the top of every screen within the SMART system, you will find a user-friendly information display
that provides key details relevant to your current session. This information is essential for keeping you
informed about your user ID, role, and the specific reporting period you are working on.

In this example, you are entering your financial needs for FY2025 Q1 (October, November, December)
and entering your quarterly status updates for work accomplished in FY2024 Q3.

BROWSER RECOMMENDATION

The recommended browser to use MS Edge with Google Chrome as a secondary browser choice.

The SMART application will automatically “time-out” after 15 minutes of inactivity. This will
require you to login again. This is a DOI security requirement and cannot be changed. It is essential
to save your work frequently. Even if you are actively typing, the system may not recognize it as
activity. For instance,if you step away from the screen while entering your Annual
Accomplishment, you may find that your data has been lost when you return. To avoid losing your
progress, make it a habit to click the SAVE button regularly. Rememeber that simply typing
doesn’t count as activity in the system, so frequest saving is crucial to protect your work.
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LOCATING YOUR PROJECTS

There are two ways to access your active projects, with the first method being the most recommended for
efficiency.

Method 1 (Recommended) — Project Search: Click on the “Project” link located in the top menu bar.
Once you access the "Project" link in the top menu bar and choose to perform a search, you can simply
click on the "Search" button without making any additional selections. This will provide you with a
complete list of all your active projects. This feature allows you to search for your projects using various
selection criteria, making it easier to narrow down your search results effectively.

! ; _ : T |
g" SNPLMA Management And Reporting Tool 6

Projects [collapse]
Capital Improvements WeLcoMmE To SNPLMA MANAGEMENT AND REPORTING ToOL

Conservation Initiatives

Environmentally Sensitive
Land Acquisitions

Hazardous Fuels Reduction
Plans and wildfire
Prevention Projects

» Clicking on “Search.” Making no additional selections will give you a complete list of all
your Active Projects.

SEARCH PrROJECT

Search |
Project Mumber : Please Selact ¥
SUb ACtVItY : | pjaage select ol |
Round :
oUNe | please Select ¥ ‘
ENGLY * | please Select v
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» Clicking on the desired Sub Activity, Round, etc. This will narrow the list of active projects
being shown within the category (those not yet closed or terminated). The screen shot below
shows the active BLM projects for the Capital Improvements category. Categories with many

active projects may require use of the scroll bar to see all projects.

SMART User Guide — January 2026
6

Project Number : [, - v|
D ARy 8 Capital Improvements b |
Round :
Please Select ¥ |
BNty © | please Select o
Search || Reset
3 items found, displaying all items.
. . - . Project
Program Category Project Of Concern: No Round Priority  Entity =
Capital Improvements Focus POC: No 18 1 0 sloftond BL55
Management
POC Color: Green Project

Menu

Project Name SNAP

Red Rock Canyon Legacy Trail Lead
SNAP

Work Plan Status: Approved

Project Status: Task Order Assigned SMPLMA Program 06/01,/24 Project is v the 5% progress rate aflowed. Funds

Start Date: 02/25/2022 Manager Comments: Ratio is within the 2 allowed. Project to remain Green.

3 Project Manager: Tira Faiivae

Curre.nt Project End 02/24/2028

Date:

Program Category Project Of Concern: Yes Round Priority  Entity Proiect

Capital Improvements Focus POC: No 18 2 STEEED T (L] BL56

Management
POC Color: Project

Menu

Project Name SHNAP

Sloan Canyon Visitor Contact Station Lead
SMNAP

Work Plan Status: Approved 06/01/24 Project is 24% behind schedule which is higher th.

Project Status: Task Order Assigned SHNPLMA Program the 5% allowed. Minumal funds spent. Project to remain Yel

Start Date: 02/21/2022 Manager Comments: for lack of progress. Project can potentially return to Green by

q making mor [g="10
Current Project End TISRING MOre progress
Date: 02/20/2027 Project Manager: Roy Fune




Method 2 Dropdown List Search: Select the desired project from the category dropdown list on the left
side of the Welcome Screen. By using this method, once a project is selected you will be taken directly to
the project menu.

SNPLMA Management And Reporting

R — AT

Input: FY 2025 Qt

financial r 1/ Status Input: FY 2024 Qir 3 Project  Reporis  Logout
Fs
Projects [collapse]
Capital Improvements SEARCH PrROJECT
= 18-1-BL55 Search |
= 18-2-BL56
= 19-2-BL5§
- Project Number : Pl Select ¥
Conservation Initiatives o ease oelec
= 16-3-BL8S D REYEy & Capital Improvements V|
= 17-1-BL86 e
= 17-3-B188 " | Please Select V|
= 17-4-BL87 T
« 18-2-BLOO [EriEEy 8 Please Select V|
Environmentally Sensitive
Land Acquisitions
Hazardous Fuels Reduction 3 items found, displaying all items.

ACCESSING PROJECT MENU SELECTIONS

Once you have located the project you wish to update, the next step is to access the Project Menu, where
you can make changes and updates.

» To make changes, click on the “Project Menu” box located to the right of the Project #.

Program Category PPP Sub Project Of Concern: No Round  Priorty Managing (Lead) Entity Drn:ecl:

Fish and Wildlife

Capital Improvements Focus POC: No 4 22 Sarvice

POC Color: Green

The Project Menu screen that will be displayed when SMART is open looks like this. The sample below
is for a Capital Improvements Project Round 17-1.

The Entity Comments box provides project managers with a convenient way to share any additional
information about the project that isn’t included in the quarterly status update. This feature allows you to

communicate important details directly within the system, eliminating the need to send a separate email to
the SNPLMA Program Manager.

When you enter comments in this box, the information is automatically sent to the System Administrator,
who will then forward it to the SNPLMA Program Manager.
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Mo Access For WorkPlan. Quarterly Status Update FY 2024 Annual Accomplishments
Enter FY 2025 Annual Accomplishments:
Closeout Inventory, ASAP Projects Only

T Project Contact Er——

Project Information

Project Of Concern: Yes Work Plan Status: Approved

POC Status: | Yellow | Focus POC: No

Project Status: Task Order Assigned Current End Date: 07/17/2029

Start Date: 07/18/2024

Status Update Based on progress reported for FY25 Q1 (thru 12/31/2024), project is under
Comments and Program the amortized completion rate by -7% as the project is reported 2% complete.
Mgr. Notes: Project is recategorized from "Green” to "Yellow" for not meeting the

amortized completion rate within a 5% variance. Once a project meets or
exceeds its amortized completion rate, it will be re-categorized as "Green” and

Lemaoved fram the POC st

Entity Comments:
Previously entered comments
have been forwarded to the
Program Manager and removed. )

Save Entity Comments

The Project Menu screen offers six menu boxes accessible to Entity users.

ProJect MENU: 20-3, DownTOWN PARK RENOVATION

Work Plan Quarterly Status Update FY 2024 Annual Accomplishments

Enter FY 2025 Annual Accomplishments

Clossout Inventory, ASAP Projects Only

Performance Measures

Project Contacts
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From top left to right, the menu boxes are:

1) Work Plan: The Work Plan menu box is only available when a new workplan is required for a
new project or if a project modification was approved.

2) Quarterly Status Update: This option allows you to enter all quarterly status information: overall
percent complete, percent completion by deliverable, actual start and end dates for deliverables,
and narrative status comments.

3) Annual Accomplishments: This menu box has three selections. The top selection is to display the
previous year’s annual accomplishment for reference only and cannot be edited unless it was never
entered. The second selection is for entering the current fiscal year’s annual accomplishments. The
third selection is for ASAP projects only to enter the projects inventory.

4) Funding Processes: This menu box allows you to enter the current funding needs for your
projects and to report the amount of committed/obligated/expended dollars. It is important to note
that this is not required for projects funded through ASAP. Regardless of whether SMART is open
or not, you can view your current “Funding Summary” here.

5) Project Contacts: This menu box allows you to verify or update project contact information.
Please confirm each quarter that this information (names, email addresses, phone numbers) are
correct. This choice is available any time, whether SMART is open or not. Note: You can only
designate one Project Manager; if you need to enter a new Project Manager, remember to delete
the previous one first.

6) Performance Measures: This is where the project Performance Measures are entered when
closing a project. There is also a checkbox labeled “Final Overall Accomplishment” to indicate
that the information entered is the overall project accomplishments required upon project closeout.

Navigating the Project Menu Screen: In the example below, the “Funding Processes” menu box has
been accessed. To return to the Project Menu Screen, click the blue “Project Menu” selection above the
title bar.

Return to Project Search Results || Project Menu

FUNDING SUMMARY: (BL86, 17-1, SPRING STEWARDSHIP AND RESTORATION IN SOUTHERN

TOTAL AMOUNT AVAILABLE : $ |638,500.00

Amount Reimbursed/Disbursed thru 7/31 : § |399,745_95

Current Reimbursement Request : $ |0,00

Amount Transferred thru 7/31 : § |0_00

Projected Funding : $ |0.00
BALANCE AVAILABLE for FUTURE REQUESTS : § [38,754.04
Percentage of Total : |37_39%

|
|
|
Current Funding Request : § |0_00 ‘
|
|
|

Direct Charge

If the Project Menu Screen was accessed using the Method 1 — Project Search then you can click “Return
to Project Search Results” to view the previous selected parameters and select another project.

SMART User Guide — January 2026
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Whereas if you used the project menu listed on left to make your project selection, keep in mind that you
will be taken back to the project menu of the project that was originally selected. The link “Return to
Project Search Results” is unavailable.

Projects [collapse]
Parks, Trails, and Natural
Areas

- 1B-12-WA10

- 20-10-WA1D

- 20-17-WA13

Work Plan Quarterly Status Update FY 2024 Annual Accomplishments
Enter FY 2025 Annual Accomplishments
Closeout Inventory, ASAP Prajects Only

T Project Conacts

Project Information

Project Of Concern: No Work Plan Status: Required
Project Status: Funds Available Current End Date:
Start Date:

Status Update
Comments and Program
Mgr. Notes:

Entity Comments:
Previously entered comments
have been forwarded to the
Program Manager and removed. 4

Save Entity Comments

» Click on “Return to Search Results” above the title row on the Project Menu Screen. This will
return you to your original search results (see below) based on the parameters that had been
previously entered.

Return to Project Search Results
PROJECT MENU: (BL50, 17-1, SPRING STEWARDSHIP AND RESTORATION IN SOUTHERN NEVADA

SMART User Guide — January 2026
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The user can now select another project to update from the original search by selecting “Project Menu” or
locate a new project by entering new search parameters.

SEARCH PROJECT

Search | Create

Project Number : Ploase Selact ¥
SubllcHuibE Please Select V‘
Round : | pjoase Select V‘
ENtity * | ploase select V|
Status : Active ~
184 items found, displaying 181 to 184.
[First/Prev] 12, 13, 14, 15, 16, 17, 18, 19 [Next/Last]
Program Category Project Of Concern: No Round Priority  Entity PrOfCt
Parks, Trails, and Natural Focus POC: No 19 13 Las Vegas Lv42
Areas
POC Color: Green Project
Menu
Project Name =NAF
Northwest Regional Park Phase 1A Lead
SNAP
Work Plan Status: Updates Needed 7/1/2024 Project workplan reviewed and updated by SNPLMA
Project Status: Task Order Assigned SNPLMA Program PM. Please review and notify SNPLMA PM. If no further
Start Date: 05/09/2024 Manager Comments: changes--the SNPLMA PM will finalize and approve the
) workplan.
Current Project End
Date- y 05/08/2029 Project Manager: Zelalem Alemu
Program Category Project Of Concern: No Round Priority  Entity Proi]";ect
Clarl Connhy
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STEP 1: CREATING A WORKPLAN FOR NEW PROJECTS

To create a work plan for a new project, first, locate the specific project that requires a work plan.

» Next click on “Project Menu” then on the “Work Plan” menu box.

bt — = EE ST el L i ST A = A ST 2
Financial Input: FY 2018 Qtr 2 / Status Input: FY 2018 Qtr 1 Project  Uploads Reports Admin

e

Projects [collapsa] Return to Project Search Results
Capital Improvements Proiect Menu: (FS80, 16-6, ENDEMIC AND SENSITIVE SPECIES BioLoGICAL MITIGATIONS FOR

e SPRING MoOUNTAINS NATIONAL RECREATION AREA CAPITAL IMPROVEMENT PROJECTS
Eastern Mevada Landscape
Restoration Project
Environmentally Sensitive
Land Acquisitions

Hazardous Fuels Reduction
Flans and Wildfire

Prevention Projects

Lzke Tshoe Restoration Work Plan Quarterly Status Update v 2017 Annual Accomplishments
Projects

Multi-Species Habitat Enter Annual Accomplishments

Conservation Plans

Parks, Trails, and Natural
Areas

Pre-Proposal Planning
(eeR)
Santini-Burton

Virgin River Habitat
Conservation Restoration
Plan and Ground Water
Monitoring

Funding Processes Project Contacts

Project Information

Project Of Concern: No Work Plan Status: Updates Needed
Project Status: Task Order Assigned Current End Date: 09/30/2022
Status Date: 10/01/2017

Status Update
Comments and Program
Magr. Notes:

SMART User Guide — January 2026
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The following screen displays with the message that “No results were found” because no deliverables,
tasks, or subtasks have yet been entered for the specific project you are viewing.

> Click on “Create New Deliverable.”

Projects [collapse’
Capital Improvements
Conservation Initiatives
Ezstern Mevada Landscape
Restoration Project

Environmentally Sansitive
Land Acquisitions

Hazardous Fuels Reduction

Project Menu
WoRrk PLAN f DELIVERABLE: (CCO02, 4-1, MSHCP FY2003 Anp FY2004)

s No results were found matching the given criteria. <G——
Project Description:
Project funding to support the 2003-2004 MSHCP Biennium. This project has been completed.

Per the Implementation Agreement, Work Plan project deliverables should be identified as
primary/anticipated/standard. This is a required field and is listed as the first criterion when you are
entering or updating information in the Work Plan. Any changes made to older Work Plans now
necessitate this classification to ensure consistency and compliance with current requirements.

» Select your Deliverable type from the drop-down.

A4

Financial Input: FY 2020 Qtr 1 / Status Input: FY 2019 Qtr 4

SNPLMA Management And Reporting Tool

Projects [collapse
Capital Improvements

Consarvation Initiatives

Eastern Nevada Landscape

Project Menu

IMPROVEMENT COMPLETION PROJECT

List Deliverables

Restoration Project
Environmentally Sensitive
Land Acquisitions
Hazardous Fuels Reduction
Plans and Wildfire
Prevention Projects

Lake Tahoe Restoration
Projects

Multi-Spacies Habitat
Conservation Plans

Parks, Trails, and Natural

Areas

Pre-Proposal Planning
PEE)

Santini-Burton

Virgin River Habitat
P —

o Dmbmmdian

Deliverable Type *

————
Please Selact
Deliverable Descriptiof

Anticipatad |
* Primary
plsendend /|

Target Start D

Target End Date : | ‘

Comments:

SMART User Guide — January 2026
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» Select a deliverable from the drop-down menu for “Deliverable Description.”

mlnput: FY 2025 Qtr 1 / Status Input: FY 2024 Qtr 3 Project ~ Uploads

SNPLMA Management And Reporting Tool

il | TP

Reports Admin  Logout

Projects [collapse]
Capital Improvements

Conservation Initiatives

Eastern Nevada Landscape
Restoration Project

Environmentally_Sensitive
Land Acquisitions

Hazardous Fuels Reduction
Plans and Wildfire
Prevention Projects

Lake Tahoe Restoration
Projects

Multi-Species Habitat
Conservation Plans

Parks, Trails, and Natural
Areas

Pre-Proposal Planning_(PPP)
Santini-Burton

Virgin River Habitat
Conservation Restoration

“| Project Menu
CREATE WORK PLAN/DELIVERABLE: (LV42, 19-13, NORTHWEST REGIONAL PARK PHASE 1A

List Deliverables

Deliverable Type *

Deliverable Descriptio
¥

}ﬂ?ﬁﬂ_v
Target start patd

Target End Dat

Comments:| Appraisal

* | Primary v

ACQUISITIONS
Additional Funding
Agreement/Contract/Grant

Biological assessment of flood control measures
Botany Mitigation Measures

Botany Surveys

Building Permits

Business Waiver

CONSTRUCTIONS

Conceptual Design

Conceptual Design/Public Scoping
Consultation
Consultation with BLM

Contract Administration

Contract for Architecture/Design

Contract for Engineering/Construction

Contract or Agreement

Contract to draft Virgin River Habitat Conservation Restoration Plan (VRHCRP) EIS |

Plan and Ground Water
Monitoring

<Back . Top~

» Enter the Target Start/ End Dates; Comments if needed.

» Click “Save.” A message will be displayed that the deliverable has been saved successfully,
and the date modified will display.

> Click on “List Deliverables” to enter tasks or subtasks for the deliverable.

> Click on “Create New Deliverable” to enter the next deliverable.

2 / Status Input: FY 2018 Qtr 1 Project  Uploads Reports Admin  Logout

Project Menu

List Deliverables I Create New Deliverable
' |

« Deliverable was saved successfully.

Deliverable Number *: [1 |

Deli ble D ipti
eliverable m"PtI:'r Conservation Management Development and Planning

05/05/2025
I Target End Date : hﬁf(_ﬁfzozs B

Madified Date:

Target Start Date :

03/01/2018 |

Comments:

SMART User Guide — January 2026
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> Click “Create Tasks.”

r 2 / Status Input: FY 2020 Qtr 1 Project Reports  Logout

Project Menu

Work PLAN/DELIVERABLE: (N101, 17-1, LowER | EHMAN CAMPGROUND RECONSTRUCTION)

Create New Deliverable

Project Description:

The Great Basin Mationzl Park (GBNP) was established in 1986 with transfer of the land from the U.S. Forest Service to the National Park Service. The Lower
Lehman Campground was originally constructed in the mid-1920s as part of the W.S., Forast Service "Operation Outdoors” initiative and has not been significantly
upgraded since that time. The Lower Lehman Campground is adjacent to the historic Wheeler Peak Scenic Drive and is the only campground in the park that is
open year round. The project will relocate three camp sites that are currently in a2 riparian meadow, and restore the meadow. An additiocnal 11 units will be added
and 2 units reconstrucked, bringing the total number of campsites to 22,

B iterns found, displaying all items.

4 Target Stark Target End. “ 4 Modified .

- Type » Commenisy

o Date 7 Date Date 7

Initial funds 5, 1) 442000 Insert|Edit| ListTasks CreateTask
kransfer

1 160, Task Order, or Initial Funding Transfer a7/01f2020 09/20/2020 Standard

» Enter the task description and any comments.
» Select the Responsible Entity.

» Click “Save.”

Project Menu
Epit Task: (LV42, 19-13, NoORTHWEST REGIONAL PARK PHASE 1A

List Tasks | Create New Task

The deliverable number and description are
displayed on each task-entry screen. This will
automatically update and re-number all
deliverables if you happen to insert/add/delete

Deliverable #5. Contract for Architecture/Design

Task Number *: |1 |

Task Description * : Othar ~

Other Description *: | pevelop SOW for design

Responsible Entity : Las Vegas

Modified Date: (06/28/2024

Comments | consistent with the SNPLMA federal award ensure to include the following a
conspicuously placed disclosure for materials generated for display or distribution l
w

(brochures, flyers, public planning documents, public scoping meetings, videos, etc.)

"This project was funded due to the Southern Nevada Public Land Management Act,

which authorized the sale of BLM-administered federal lands within a designated

boundary in the Las Vegas Valley and required proceeds to be used on projects to fund

A message will be displayed that the task has been saved, and the date modified will display.

Review your entry. If you need to make a change in the description or comments, do so and then click
update. When you are satisfied with the task entry, you can move on to entering subtasks for this task or
enter a new task for the displayed deliverable.

SMART User Guide — January 2026
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EpiTt Task: (LC19, 1

List Tasks | Create New Task

6, ALAMO SPoRTS COMPLEX

+ Task was saved successfully.

Deliverable #1. Cooperative Agreement with BLM SNPLMA

Task Number *: |1

Task Description * : Other v

[
‘ Other Description *: |gpecial Account Funds Notice

Responsbielenig: Bureau of Land Management

[ Modified Date: Jos/26/2024 |
Comments |ygne

> Click on “List Tasks” to enter subtasks or to create an additional new task for the deliverable.

WoRrkK PLAN/DELIVERABLE: LAMO SpoRrTtS COMPLEX

Create New Deliverable

Project Description:

Lincoln County will construct a 1-acre outdoor sports complex on county-owned land north of Box Canyon Road and west of Joshua Tree Street in Alamo, Lincoln
County, Nevada. The complex will consist of a basketball court, tennis court, two pickleball courts, lighting for after dark use, and a parking lot. Each court will be
divided by fencing for safe enjoyable uses. The Alamo Sports Complex will promote community engagement and outdoor recreation.

10 items found, displaying all items.

lew a|Target S | Target End a Modified

Cooperative Agreement with BLM SNPLMA 12/01/2023 08/01/2024  Standard 11/01/2023 Insert|EditfListTasks [CreateTask
2 Other: Project Reporting: Performance and 12/01/2023  11/30/2028  Standard 11/01/2023 Insert|Edit|ListTasks|CreateTask
Financial Status
National Historic Preservation Act Analysis e
3 (Saction 106 Consultation) 12/01/2023 08/01/2024  Standard 11/01/2023 Insert|Edit|ListTasks|CreateTask
Federal Environmental Law Compliance (NEPA, -
4 Encangared Spedies Adt, etc.) 12/01/2023 12/31/2024  Standard 08/01/2024 Insert|Edit|ListTasks|CreateTask
5 SNPLMA Notice to Proceed 12/01/2023 10/31/2024  Standard 08/01/2024 Insert|Edit|ListTasks|CreateTask

- T T T P P N L Lo -1 P Y T S o PV PP S B R S

» After clicking on “List Tasks” if you get this screen you will need to enter your task.

Projects [collapse] Project Menu
Capital Improvements Task: (BL0O3, 1-6, Lockes RANCH)

Conservation Initistives List Deliverables I Create New Task

Eastern Nevada Landscape
Restoration Project Deliverable #1. Additional Funding

Environmentally Sensitive
Land Acguisitions
Hazardous Fuels Reduction
Flans and Wildfire
Prevention Projects

SMART User Guide — January 2026
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» Otherwise, you will see something like this and here you will click on “List Subtasks.”

Project Menu

Task: (BR10, 16-1, CoLorADO RIvVER HERITAGE TRAIL - ARTZONA)

List Deliverables I Create Mew Task

Deliverable #1. Project initiation, authorization to expend SNPLMA Project Funds and confirmation of the period of performance (IGO, Task Order,
or Initial Funding Transfer Authorization)

5 items found, displaying all items=.

Modified.
Date

4+ Responsible.
N ——

Notification of funds
1 Other: Motification of funds availability Eoisniktyicentit 12/20/2016 Inser':IEdi|| ListSubtzsks 'l:reateE.ubtask

entities via email on
12/20/2016

Draft plan entared for

Bre= of the BOR by the SNELMA 12/20/2016 Insert|Edit|ListSubtasks|CreateSubtask
Reclamation ... N

T"_’;k Task Description Comments = Actions

2 Other: Prepare and input the work plan inte SMART

> Click on “Create New Subtask.”

Projects [collapse] Project Menu
Capital Improvements SueTAask: (BLO3, 1-6, Lockes RANCH)

Conservation Initiatives

List Tasks | Create New Subtask

Eastern Nevada Landscape

Restoration Project Deliverable #1. Additional Funding
Environmentally Sensitive Task #1. Other

Land Acquisitions

This screen will show you all the tasks, this sample only has one and you can see what the Deliverable is
and the Task #.

» Enter the subtask description and any comments.
» Select the Responsible Entity.
» Click “Save.”

Project Menu
Create Sustask: (BLO3, 1-6, Lockes RancH)

List Subf

Deliverable #1. Additional Funding

Task #1.Other Note that both the applicable Deliverable and Task
Subtck becriton s [ ] | AT€ displayed above the Subtask Description Field.

Other Description *: [Tecting

Responsible Entity : | )itornia State parks L‘

Comments |Make it work........... |
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After entering a subtask and clicking the "Save" button, you will see a message confirming that the
subtask has been saved successfully. This notification indicates that your entry was recorded without
issues. You can then review the saved subtask, make any necessary edits, and click "Update" to apply
your changes.

Once you have finalized the subtask information, you can proceed to enter additional subtasks, tasks, or
deliverables as needed.

>

To enter a new deliverable, you will need to exit the subtask screen. To do this, click "List
Subtasks" first, then click "List Tasks," and finally click "List Deliverables." This
sequence of actions will navigate you back to the “Create New Deliverable” screen, where
you will see the project description displayed.

STEP 2: UPDATING QUARTERLY STATUS

>

>

Click on the “Project Menu” box of the project to be updated.

To access the project deliverables, click on the “Quarterly Status Update” menu box. As you
prepare your report, it's important to remember that you should only report on deliverables
with a Target Start Date passed and deliverables not reported at 100% complete. If the
deliverable is reported at 100% or the Target Start Date has not passed, then no quarterly status
report is needed. This focus ensures that your quarterly updates reflect only the progress and
status of relevant deliverables, making your reporting more accurate and meaningful.

Return to Project Search Rasults

ProJect Menu: (WPO01, 8-7, NeEvaDA NORTHERN HISTORIC RATLROAD MUSEUM INTERPRETIVE TRAIL

Work Plan Approved. work Plans are | | - YR TTRTS—
et T b (O s e, Quarterly Status Update FY 2017 Annual Accomplishments

Project Information

Project Of Concern: No Work Plan Status: Approved

Project Status: Closed Current End Date: 07/16/2013

Status Date: 01/21/2014
Status Update

Comments and Program

Mgr. Notes:

SMART User Guide — January 2026
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When you access the Quarterly Status Update, you will be able to see the following information:

e Overall Project Complete Percentage: This percentage reflects how much of the entire
project is complete, allowing you to assess progress at a glance.

e Deliverable Type: this indiciates the category of each deliverable providing context for its
classification.

o List of tasks for the Deliverable: Here, you can view the specific tasks associated with the
deliverable helping to understand what work is required or in progress.

e Previous Quarter’s status Comments and Percent Complete: If updates were previously
entered, you will see the status comments from the last quarter along with the percent complete
metric.

e Actual Start and End Dates: If any actual start and end dates have been entered, these will be
displayed as well, giving you a clear timeline for the deliverable.

If there are more deliverables than can fit on a single page, you will find additional deliverables available
on subsequent pages, ensuring that you have access to all relevant information for your reporting needs.

QUARTERLY StaTUSs: (HN47, 18-10, THERAPEUTIC RECREATION AND INCLUSION CENTER

Create New Quarterly Status

Current Statuses

Please enter Overall Project Complete Percentage (Copied to the - . o
Financial DB each quarter) Overall Project Complete Percentage:

9 items found, displaying all items.

Deliverable #: 1
Type: Standard

Cooperative Agreement with BLM SNPLMA Target Start Target End Actual Start Actual End
Date Date Date Date
02/01/2022 12/31/2022 02/01/2022* 12/30/2022*
Tasks:

#1: Other: Receive Special Accounts Funds Notice

#2: Other: Receive Notice of Funding Opportunity

#3: Other: Initial project site/virtual meeting

#4; Other: Acceptable Work Plan in SMART

#5: Other: Submit SF424A Application Package via Grant Solutions

#6: Other: Request to Initiate Project transmittal to BLM SNPLMA Division

#7: Other: Obtain Federal financial award (cooperative agreement) from BLM GMO

Current Quarterly Status Percent Complete: 100% I

FY/Qtr Entry Date: 2024 Q4

Previous Quarterly Status N
SNPLMA financial assistance agreement awarded 12/30/2022 with a 5-year period of performance ending 12/29/2027.

FY/Qtr Entry Date: 2024 Q1
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» To navigate through the list of deliverables, you can click on the “[First/Prev]” or

“[Next/Last]” page number options.

Create New Quarterly Status

Current Statuses

Please enter Overall Project Complete Percentage

15 items found, displaying 1 to 10.
[First/Prev] 1, 2 [Next/Last]

Overall Project Complate Percentage: G

» To update the status of the desired deliverable, click the “Add” button.

Actual Start Date and Percent Complete are required to enter/update the status of a deliverable. You
cannot enter an “Actual Start Date” that is in the future; the date must be today or a date that has already

passed.

Create New Quarterly Status

Current Statuses

lease enter Overall Project Complete Percentage (Copied to the
‘inancial DB each quarter)

L6 items found, displaying 11 to 16.
First/Prev] 1, 2 [Next/Last]

Overall Project Complete Percentage: %

Deliverable #: 11

Type: Primary
Executed Deed Target Start
Date
02/03/2025
Tasks:

#1: Draft Deed Conveying Property

#2: Approve Text of Deed (Solicitor/OGC)
#3: Execute Deed (Seller)

#4: Deposit Executed Deed into Escrow

Target End Actual Start Actual End
Date Date Date
02/07/2025

Current Quarterly Status Percent Complete:

FY/Qtr Entry Date: 2024 Q4

Previous Quarterly Status
-No Previous Quarterly Status-

FY/Qtr Entry Date: (none)
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a
jects [collapse] Return to Project Search Results | Project Menu

ital Improvements REA OuUAR R A b6 : oA PEA AND Aco D

servation Inifiatives Workplan information is exported to the Compliance Insp DB for applicable projects at closeout.

tern Nevada Landscape L Iv S

‘oration Project ist Quarterly Statuses

ironmentally Sensitive Work Plan Deli ble *: . . . .
LAcquisitions oriTan REEIRTE ™ [#1. 160, Task Order, or nital Tranfer Note the Calendar icon; click on this
ardous Fuels Reduction Actual Start Date *: ‘06/15/2023 ‘a

s and Wikfire to select the date from a calendar by
rention Projects Actual End Date : ‘10/11/2023 ‘a

2 Tahoe Restoration

ects Percent Complete *: [7q ‘ month a'nd year'

ti-Species Habitat Quarterly Status Update

servation Plans Detail *:

¢s, Trails, and Natural
s

-Proposal Planning_(PPP)

tini-Burton

in River Habitat
servation Restoration
1 and Ground Water
litoring

REQUIRED: YOU MUST ENTER DATA IN THE REQUIRED FIELDS.
IF YOU DO NOT, ANY DETAIL ITEMS YOU ENTERED WILL NOT BE SAVED!

(0% IS A VALID PERCENT COMPLETE TO USE SHOULD YOU NEED TO DO S0.)

It is crucial to enter only “ACTUAL” Start and End Dates in the designated buckets for Actual Start Date
and Actual End Date. Estimates or guesses regarding these dates are not acceptable, as an actual date must
be a date that has already occurred. Remember that an actual date cannot be in the future—only dates that
have come to pass are valid.

Additionally, please note that a Percent Complete value of 0% is also valid and can be used. If you find
yourself needing to update or change any of this information, SNPLMA Program Managers have the
ability to make those adjustments. Be sure to reach out to them for any necessary changes or
clarifications.

> Enter the Actual Start Date: Input the date when the deliverable actually began.

> Enter the Percent Complete: Input the percentage of completion as a whole number (e.g., 5,
25,50, 75, 97). Do not include a percent sign, as the system is set up to recognize whole
numbers only.

> Enter the Actual End Date: This field should only be filled in if the deliverable is 100
percent complete. If the deliverable is not yet fully complete, leave this field blank.

> Enter the Narrative Description of the Project Status: Write a detailed status update that
includes information on the work completed, any issues currently being addressed, and the
status of their resolution. This narrative proivdes important context and insights into the
project’s progress.
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SNPLMA Management And Reporting Tool

ey e

tr 2 / Status Input: FY 2018 Qtr 1 Project  Reports

T e X e R s

Logout

Project Menu

CreATE QUARTERLY StTATUSs: (F145, 10-3, UrPER TRUCKEE RIVER RESTORATION - SUNSET BEACH)
List Quarterly

Work Plan Deli ble *: -
or an Deliveran’e #1, IGO0, Task Order, or Initial Funding Transfer |
—

Actual Start Date *: [04/01/2010 |@

Actual End Date : [p5/30/2010 |

Percent Complete *: |

Quarterly Status Update
Detail *:

REQUIRED: YOU MUS ATA IN THE REQUIRED FIELDS.

IF YOU DO NOT, ANY DETAIL ITEMS YOU ENTERED WILL NOT BE SAVED!
(0% IS A VALID PERCENT COMPLETE TO USE SHOULD YOU NEED TO DO 50.)

» Click “Save” when done entering current status information.

After you have completed your entry and clicked “Save,” you will see a message confirming that the
“Quarterly Status was saved successfully.” It is highly recommended that you review the entry at this
point to ensure that all information is correct before proceeding to update the next deliverable.

» To return to the list of deliverables, click on “List Quarterly Statuses.”

Project Menu

List Quarterly Statuses JJ| Create New Quarterly Status

& Quarterly Status was saved successfully.

Work Plan Deliverable *: (21 150, Task Order, or Initial Funding Transfer
Fiscal Year: [2018

Quarter: |01
Actual Start Date *: [04/01/2010 |a
Actual End Date : [05/30/2010 |a

Percent Complete *: (1

Madified Date: (p35/07/2018

Quarterly Status Update g detail to report.
Detail *:

REQUIRED: YOU MUST ENTER DATA IN THE REQUIRED FIELDS.

IF YOU DO NOT, ANY DETAIL ITEMS YOU ENTERED WILL NOT BE SAVED!
(0% IS A VALID PERCENT COMPLETE TO USE SHOULD YOU NEED TO DO S0.)
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The updated information will now be reflected under the deliverable(s) that have been updated. You will
notice that instead of the “Add” button, an “Add/Edit” button appears in its place. This change indicates

that the deliverable has been updated successfully and provides you an option to edit the entry if further
adjustments are needed.

Return to Project Search Results | Project Menu

QuUARTERLY StaTUS: (FS86, 17-1, SPRING STEWARDSHIP AND RESTORATION IN SOUTHERN

Create New Quarterly Status

Please enter Overall Project Complete Percentage

Current Statuses

6 items found, displaying all items.

Overall Project Complete Percentage: %

#2:
#3:
#4:
#5:

Other:
Other:
Other:
Other:

Deliverable #: 1

Other: Funding Instrument and confirmation of the period of

AT Target Start Target End
Date Date
08/01/2019 07/31/2020
Tasks:
#1: Other: Notification of Availability of Funds

Draft Work Plan, preliminary Target Start and End dates entered into SMART

Work Plan approval

Entity request to initiate the project

Authorization to Expend SNPLMA Project Funds and/or Funding instrument processed/approved

Actual Start Actual End
Date Date
08/01/2019 02/18/2020

Current Quarterly Status Percent Complete: 100%
testing showing data

Previous Quarterly Status

Project initiation letter and initial funding request was submitted by the Forest Service on January 24, 2020. Authorization to expend funds letter
and official start date of the project was received on February 18, 2020. Period of performance is from 02/18/2020 to 02/17/2025.

Repeat this process for each deliverable that has been started and not reported at 100% for the project
until all required updates are complete.
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STEP 3: FUNDING REQUESTS

» To return to the Project Menu screen, click on “Project Menu.”

SNPLMA Management And Reporting Tool ﬁ

e R e T R e T et

tr 2 [ Status Input: FY 2018 Qir 1 Pruject h

Project Menu

QuARTERLY StaTus: (F145, 10-3, UrPER TRUCKEE RIVER RESTORATION — SUNSET BEACH)

Create New Quarterly Status

Current Statuses

Please enter Overall Project Complete Percentage Overall Project Complete Percentage: %o

& items found. disolavina all iterns.

» Click on the “Funding Processes” menu box.

Note: Funding requests can be edited until SMART closes. After you save your funding request, entity
users will see an “Update” button. This allows you to make changes or add additional information as
needed. Once you’ve made the desired edits, remember to click the “Update” button to save those

changes.

However, keep in mind that if the SNPLMA Program Manager has already “Approved” your request, you
will not be able to make any changes, even if SMART is still open.

Return to Project Search Results
ProJect Menu: (F145, 10-3, UrPER TRUCKEE RIVER RESTORATION - SUNSET BEA(

Mo Access For WorkPlan. Quarterly Status Update Fr 2017 Annug
Enter Annual
Funding Processes Project Contacts
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When you navigate to the next screen, keep in mind that the button you see will indicate the financial
instrument through which your agency or entity receives SNPLMA funding. This could be one of several
options, such as Reimbursement, Direct Charge, ASAP, or Transfer.

ASAP Funding Requests

The first screen you will encounter is the “Funding Summary” page. It is important to note that no entries
are made on this page; rather, it serves as a snapshot of your current funding status.

» To proceed to the funding request page, click on the ASAP button.

Return to Project Search Results | Project Menu

FunDING SuMMARY: (WP15, 18-9, HERITAGE PARK ACQUISITION AND CONSTRUCTION
TOTAL AMOUNT AVAILABLE : $ [24,606,829.00 |

Amount Reimbursed/Disbursed thru 7/31 : $ |3 427.06

Projected ASAP Request : $ ‘100]000_00 |
BALANCE AVAILABLE for FUTURE REQUESTS : § ‘24'4981401_94 |

Percentage of Total : ‘99_55% |

On the ASAP fund request page, users can enter information into four specific fields:

e Entity Project/Accounting Number — Completing this field is optional. You may include this
number if it helps you track your project or funding, but it is not required.

e Current ASAP Request — This field is where you enter the anticipated amount you are requesting
for the upcoming quarter. This figure should reflect the funds you expect to need to support your
project activities during that period.

e Final ASAP Closeout — Click this box when submitting your last funding request. Not necessarily
always at closeout.

e ASAP Comments — This field is used to explain or justify the Current ASAP request amount (i.e.,
purpose of funds that will be drawn down).
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ASAP Summary Project Menu

ASAP RequesT: (LV38, 13-1, Froyp LaMB PARK AT TULE SPRINGS ACCESS TRAIL)

Status : |Pending

| Entity Project/Accounting Nu

mber |

le to ASAP R

Amount Rema

Q3
Q4,
01

Prior ASAP Requests

2017: £|5,000.00
2017: %|10,000.00

t: % (250,000

oo

Amount Reimbursed /Disbursed : %105 451,

55

ining : (134,508,

05

2018: % |cn nnn

Current Financial Qu:

ASAP Comments:

arter : 3,/31/2018
—

Current ASAP Request : § m

Final ASAP Closeout : ]

In the example below, the “Current ASAP Request” is $0.00 (entered without symbols or commas) and
the purpose of the request to purchase materials has been entered in “ASAP Comments.”

» After entering the request amount, justification comments, and any other relevant information
in the necessary fields, be sure to click the “Save” button.

ASAP Summary Project Menu

ASAP Request: (LV20, 6-11, Las VEcAs WASH TRAIL, PHAS)

Status

Amount Reimbursed [ Disbursad

Q3, 2017
Q4, 2017
Q1, 2018
Current ASAP Request

Entity Project/Accounting Number :
Amount Available to ASAP Request :

Amount Remaining :

Prior ASAP Requests

Final ASAP Closeout :
Current Financial Quarter :

ASAP Comments:

¢ [Pending

£[5,000,000.00

: $[4,194,832.41

£(1,805,167.55

50,000.00

125,000.00

t %
P %
: $[50,000.00
t %

/

0.00

O

3/31/2018

After saving, click on ASAP
Summary to return to financial
summary page and confirm that the
request is reflected correctly.

If you try to enter a request without
comments you will see

» Comments are required. 454 your
request will not be saved until you
enter comments.

The funds are needed to cover materials needed for construction)|

Csave | cance]

After clicking “save,” a message in green text that reads “Financial Request was saved successfully” in

the upper left portion of the screen will appear.

» Next click “ASAP Summary” to return to the financial summary page. Review the fund
summary page to ensure the amount requested is accurately reflected. Additionally, check that
the “Balance Available for Future Requests” has been recalculated to reflect a reduction equal

to the amount requested.
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Transfer Funding Requests

Each funding request method is fundamentally similar, with only slight variations in the process. The
screen shot below illustrates the Financial Summary page for a project funded by 1151 Direct Transfer.

On this page, no entries are made on this page.
» To proceed with entering a funding request using a transfer method, click on the “Transfer”

button. This will take you to the funding request page where you can enter the necessary
details for your funding request related to the transfer.

Return to Project Search Results | Project Menu

FunbDiING SummaRry: (NP89, 18-1, ProTECTING WiLD CAVES

TOTAL AMOUNT AVAILABLE : 1,735,460.00
0.00
0.00

$
$
$
Amount Transferred thru 7/31 : $ |1,168,000.00
$
$
$

Amount Reimbursed/Disbursed thru 7/31 :

Current Reimbursement Request :

Current Funding Request : $ |25 000.00

0.00

Projected Funding :
BALANCE AVAILABLE for FUTURE REQUESTS :

542,460.00
Percentage of Total : ‘31.25%

Transfer

Note: In the funding request section, you may see fields for “Current Reimbursement Request,” “Current
Direct Charge,” and “Current Transfer Request.” The appropriate text displayed will correspond to the
type of funding instrument for the selected project.

For example, in this NP89 scenario, direct transfer is the sole method of funding for many Federal
projects. In some cases, older projects may have initially been funded with reimbursement and later
transitioned to direct transfer. If you encounter a situation where more than one funding method button
appears, make sure to select only the current funding method relevant to your project. This will help
ensure that your funding request is processed correctly and aligns with the project's current funding
structure.

On the Transfer fund request page, entities can enter information in five specific fields:

o Entity Project/Accounting Number — Completing this field is optional. While you can include
this number for your own tracking purposes, it is not mandatory for the funding request.

e Total Transferred Funds Expended/Obligated Thru ... — This information is required. Input
the total amount of project funds that have been committed/obligated/expended through the
specific date annotated. A more current figure can be used if it is available, at a minimum, we
require the amount recorded as of the end of the previous quarter. The figure is essential for
checking compliance with the “95% Rule,” which ensures that funds are being utilized
appropriately. Moreover, this number will be taken into consideration when approving your
current request.

e Current Transfer Request — In this field, you will enter the amount you are currently requesting
for the upcoming quarter. This amount will be reflected on the financial summary page once
submitted.
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¢ Final Transfer Closeout — Click this box when making your last funding request. Not necessarily
always at closeout.

e Transfer Comments — This field is mandatory if you have entered an amount in the Current
Transfer Request box. Use this space to explain or justify the requested amount, detailing why the
funds are needed for the upcoming quarter as opposed to a later time (e.g., specific projects or
expenses that require immediate funding). Additionally, this comments section can also be used to
explain or justify the remaining available funds from previous quarter(s), regardless of whether
you are requesting new funds.

r 4 / Status Input: FY 2021 Qtr 2 Project  Reports (Hyp) Reports  Logout P e A TR T

Return to Project Search Results | Fund Summary | Project Menu

TRANSFER REQUEST:

Be sure to input a current Expended/Obligated dollar figure.

Status : | pending
I Entity Project/Accounting Number : I

200 77000 |

Gis

Amount Available to Transfer :

Total Transferred Funds Expended/Obligated Thru 3/31/2021 : $|514 725.00 89%

Amount Transierred Thru 3/31: £90,000.00
9% of Funds Expended/Obligated : |89.[19

Prior Transfer Requests

i

)

Q4, 2020: $|g.00
Q1, 2021: %|20,000.00
Q2, 2021: $|0.00
I Current Transfer Request : $|0.00 For Funding Thru 9/30/2021 I
Balance Available for Next Transfer : $|309,720.00 |
I Final Transfer Closeout : |
2 6;"3_0@21
Transfer Comments*:
P
Cancel

FunDING HISTORY

One item found.

Date Requested * Date Rejected < [Fiscal Year ¢ |Quarter __%|Request Amount clstatus ___<lactions

10/02/2017 11/13/2017 2018 Q1 120000.00 Rejected View

e Funding History Section: This area here will give you a history of what has occurred with your
funding requests (Approval/Rejections).

» After entering the required information, click “Save.”

A message will appear stating that “Financial Request was saved successfully.” Additionally, the “% of
Funds Expended/Obligated” will be automatically calculated based on the amount entered under “Total
Transferred Funds Expended/Obligated Thru #/##/####.”

» To return to the financial summary page, click on “Fund Summary.”
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2 { Status Input: FY 2018 Qtr 1 ijecf

e T = R

Logout

It is highly recommended that entities review the Financial Summary page after submitting a funding
request. This review will allow you to ensure that the amount you requested is accurately reflected.
Additionally, check that the “Balance Available for Future Requests” reflects a reduction that includes
both the previous transfers and the new request.

Return to Project Search Results | Project Menu
» X: PSS N RO [
TOTAL AMOUNT AVAILABLE : $ 1,735,460.00
Amount Reimbursed/Disbursed thru 7/31 : $ |0.00
Current Reimbursement Request : $ |0_00 |
Amount Transferred thru7/31: $ |1,168,000.00 |

Current Funding Request : $ (25 000.00

Projected Funding : $ |p.00
BALANCE AVAILABLE for FUTURE REQUESTS : § [542,460.00
Percentage of Total : |31 269,

Direct Charge Funding Request

For BLM projects, funding is now provided through Direct Charge. The Direct Charge Financial
Summary page contains the same fields as those found in projects funded by Transfer. Similar to other
financial instruments, no entries are made on this page.

» To access the fund request page, click the “Direct Charge” button.

| Return to Project Search Results | Project Menu
FuNDING SummMmAaRry: (BL91, 18-5, MuppY RiveEr FLoOODPLAIN RESTORATION

TOTAL AMOUNT AVAILABLE : $ 3,419,670.00
| Amount Reimbursed/Disbursed thru 7/31 : $ 124 450 67
Current Reimbursement Request : $ |0.00
Amount Transferred thru 7/31 : $ |0.00
Current Funding Request : $ |p_oo0
Projected Funding : $ ‘100,000.00
BALANCE AVAILABLE for FUTURE REQUESTS : $ 3,195,210.33
Percentage of Total : (93 449,
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For projects funded by Direct Charge, the amount will be displayed as “Amount Reimbursed/Disbursed
through ##/##/####.” This figure indicates the total amount that has been paid out and does not include
any amounts that are obligated on contracts or agreements but have not yet been paid, which are referred
to as unliquidated obligations.

Entities can enter information in five fields on the Direct Charge fund request page:

o Entity Project/Accounting Number — Completing this field is optional. While you can include
this number for your own tracking purposes, it is not mandatory for the funding request.

e Total Charged Funds Expended/Obligated Thru ##/##/#### - This information is required.
Input the total amount of project funds that have been committed/obligated/expended through the
specific date annotated. A more current figure can be used if it is available, at a minimum, we
require the amount recorded as of the end of the previous quarter.

e Current Direct Charge Request — Although it is not required to enter the funding request,
providing this information is beneficial as it aids the SNPLMA Division in evaluating your
funding request more effectively. If this data is available, you should enter it to support your
application. Once submitted, this amount will be reflected on the financial summary page,
contributing to a comprehensive overview of your project’s financial status.

¢ Final Direct Charge Closeout — Click this box when making your last funding request. Not
necessarily always at closeout.

¢ Direct Charge Comments — This field is mandatory if you have entered an amount in the Current
Transfer Request box. Use this space to explain or justify the requested amount, detailing why the
funds are needed for the upcoming quarter as opposed to a later time (e.g., specific projects or
expenses that require immediate funding).

- . DEET ST 7 3 B —— = e e m ——
‘2 / Status Input: FY 2018 Qtr 1 Project  Reports  Logout T TLI R e e

Fund Summary | Project Menu

Be sure to input a current Expended/Obligated dollar figure.

Status : Pending
I Entity Project/Accounting Number : I

I Total Charged Funds Expended/ Obligated Thru 12/31/2017 : $|D.UU I

Prior Direct Charge Requests
Q3, 2017:

Q1, 2018: 0.00

$

Q4, 2017: $(50,000.00
$
H

Current Direct Charge Request :

Final Direct Charge Closeout :

Current Financial Quarter : 3/31/2018
Direct Charge Comments:
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In this example, $199,651.55 has been entered as “Total Charged Funds Expended/Obligated.” This
figure includes amounts obligated on contracts/agreements but not yet paid, also known as unliquidated
obligations.

Additionally, a current direct charge request of $20,000 is entered, along with an explanation or
justification for why these funds will be needed during this quarter.

Fund Summary | Project Menu

DIRecT CHARGE REQUEST: (BL84, 16-2, BUILDING STEWARDSHIP OF PUBLIC LANDS WITH DISP
User GrROUPS

Be sure to input a current ExpendedfObligated dollar figure.

Status : Pending
Entity ProjectfAccounting Number :

I Total Charged Funds Expended/Obligated Thru 12/31 /2017 $|199’551_55 I

Prior Direct Eharge Requests

Q3, 2017: £|189,000.00
Q4, 2017: £(20,000.00

Q1, 2018: £|20,000.00
I Current Direct Charge Request : % (70 goo.00
—=

Final Direct Charge Closeout : O

Current Financial Quarter : 3/31/2018

Direct Charge Comments: |Fynds will be applied to additional clean ups, labor for outreach,

education, and enforcement of requlations.

[ save | concel

» After you have entered the necessary information, including the total charged funds
expended/obligated, the current direct charge request amount, and the explanation or
justification for the funding, click the “Save” button.

After clicking “Save,” you will see a message in green text that reads “Financial Request was saved
successfully” in the upper left portion of the screen.

Fund Summary | Project Menu

DirecT CHARGE REQuEsT: (BL84, 16-2, BUulLDING STEWARDSHIP OF PuBLic LanDs wiTH Disp
User GRoOuPs

I #» Financial Request was saved successfully. I

Be sure to input a current Expended/Obligated dollar figure.

Entity Project/Accounting Number :

Total Charged Funds Expended/Obligated Thru 12/31/2017 : $ 199,651.55

Prior Direct Charge Requests

Q32, 2017: £|185,000.00

Q4, 2017: £(30,000.00

Q1, 2018: %(20,000.00
Current Direct Charge Request : § 20,000.00

Final Direct Charge Closeout : D

Current Financial Quarter : 3/31/2018

Direct Charge Comments: |Funds will be applied to additional clean ups, labor for outreach,

education, and enforcement of regulations.
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» To return to the Financial Summary page, click “Fund Summary.”

It is highly recommended that entities review the Financial Summary page following the submission of
their funding request. This review will help ensure that the amount you requested is accurately reflected
and that the “Balance Available for Future Requests” has been recalculated to show a reduction
equivalent to the amount you requested.

Reimbursement Funding Requests

» To proceed with managing your funding details, click on the “Funding Processes” menu box
from the Project Menu Screen.

+2 [ Status Input: FY 2018 Qtr 1 Project  Reports Logout

Return to Project Search Results

ProJecT Menu: (B007, 11-13, UpPER TRUCKEE RIVER AND MARSH RESTORATION PROJECT - DESIGN)

No Access For WorkPlan. Quarterly Status Update FY 2017 Annual Accomplishments
Enter Annual Accomplishments
I Funding Processes I Project Contacts

» Next, click on the “Reimbursement” button within the Funding Processes menu. This will
take you to the specific page dedicated to managing reimbursement requests for your project

FunpinG SumMaRry: (B020, 17-4, MuLti-JurispicTioNAL Noxious AND INvasIVE WEED

PARTNERSHIP

TOTAL AMOUNT AVAILABLE : $ |24,000.00

Amount Reimbursed/Disbursed thru 7/31 : § ‘21,909.86

Current Reimbursement Request : $ ‘0_00

Amount Transferred thru 7/31 : $ ‘0_00

Projected Funding : $ ‘0_00

BALANCE AVAILABLE for FUTURE REQUESTS : § 2,090.14
Percentage of Total : ‘8.71%

|
|
|
Current Funding Request : $ ‘0.00 |
|
|
|

Direct Charge
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Entities can enter information in five fields on the Reimbursement fund request page:

e Entity Project/Accounting Number — This field is optional. You can include this number for
your own tracking purposes, but it is not required for the funding request.

e Total Reimbursed Funds Expended/Obligated Thru ... This information is required. Input the
total amount of project funds that have been committed/obligated/expended through the specific
date annotated. A more current figure can be used if it is available, at a minimum, we require the
amount recorded as of the end of the previous quarter.

e Current Reimbursement Request — In this field, you will specify the amount you are requesting
for reimbursement. This amount will be reflected on the financial summary page once you save or
update your request.

¢ Final Reimbursement Closeout — Click this box when making your last funding request. Not
necessarily always at closeout.

¢ Reimbursement Comments — This field is mandatory if you have entered an amount in the
Current Reimbursement Request box. Use this space to explain or justify the requested amount,
detailing why the funds are needed for the upcoming quarter as opposed to a later time (e.g.,
specific projects or expenses that require immediate funding).

» Make the appropriate entries, then click “Save” or “Update.”
(The screen print below shows “update” because it was edited during final testing of the application.)

Fund Summary | Project Menu
REIMBURSEMENT REqQuEsT: (B003, 7-19, EIP 950, RESTORATION OF THE LAKE VALLEY REACH O
UrPER TRUCKEE RIVER

Be sure to input a current Expended/Obligated dollar figure.

Status :

Entity Project/Accounting Mumber :

Amount Available to Reimburse : $(375,000.00
I Total Reimbursed Funds Expended/Obligated Thru %|g 00 I

Amount Reimbursed"m.ji i g 15,575.51

Amount Remaining : $(850,420.45

Prior Reimbursement Requests

Q3, 2017: 0.00

0.00

Q4, 2017:

$
$

Q1, 2018: £(g,.00
H

Current Reimbursement Request :

Final Reimbur cl t: 7]

Current Financial Quarter : 3/31/2018

Reimbursement Comments:

_______

After you click “Save,” a message in green text will appear in the upper left portion of the screen that says
“Financial Request was saved successfully.” This confirmation indicates that your reimbursement
request has been successfully recorded in the system.
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» To return to the Financial Summary page, click on the “Fund Summary” option.

It is recommended that Entities review the Financial Summary page to ensure the amount requested is
reflected and that the “Balance Available for Future Requests” has been recalculated reflecting a
reduction equal to the amount requested to confirm the data entered is reflected correctly on the Financial
Summary page.

» Click on the “Project Menu” option to move to the next step in the quarterly update process.

Return to Project Search Results
Funping SummMmary: (E019, 18-8, ComMmuNITY-BASED WATERSHED STRATEGY

TOTAL AMOUNT AVAILABLE : $ |250,000.00

Amount Reimbursed/Disbursed thru 7/31 : $ ‘113]272_36

Current Reimbursement Request : § ‘33,000_00

Amount Transferred thru 7/31 : § ‘0_00

Projected Funding : $ [0.00

BALANCE AVAILABLE for FUTURE REQUESTS : $ ‘103]727_64

|
|
|
Current Funding Request : $ ‘0_00 ‘
|
|
|

Percentage of Total : ‘41_49%

STEP 4: CONTACTS
» Click the “Project Contacts” menu box.

+2 [ Status Input: FY 2018 Qtr 1 Project  Reports  Logout

Return to Project Search Results
ProJect Menu: (NP83, 16-1, CAN LAND MANAGERS PREVENT THE "INEVITABLE COLLAPSE"OF BATS IN

THE WESTERN US?

No Access For WorkPlan. Y 2017 Annual Accomplihments
Enter Annual Accomplishments
Precs Cotacts

Project Information

Project Of Concern: No Work Plan Status: Approved
Project Status: Task Order Assigned Current End Date: 02/21/2022
Status Date: 02/22/2017

Status Update
Comments and Program
Mgr. Notes:

<Back I Top~
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» To ensure that your project's contact information is accurate, review all details, including
phone numbers, email addresses, and any other relevant information.

If you notice any inaccuracies or need to make updates, click the “Edit” button. This will
allow you to modify the contact information as needed. After making the necessary
changes, be sure to save the updates to ensure that all contact details remain current and

accurate for project management purposes.

Project Menu
SeEARCH ConTAcT: (NP83, 16-1, CAN LAND MANAGERS PREVENT THE "INEVITABLE COLLAPSE OF BATS

IN THE WESTERN UU57?
List | Create

3 items found, displaying all items.

Type “ First Namef Last Namd +* Phone Number & Phone Number 25
Financial Specialist  Anita Hansen Administrative Officar 773-234-7501 anita_hansen@nps.gov dit
Other Een Roberts Chief of Matural Resource Mgmt  775-234-7561 ben_roberts@nps.gov
Project Manager Eyan Hamilton wildlife Biclogist 775-234-7563 bryan_hamilton@nps.gov  Edit

» Click “Update” when changes are complete.

- 2 [ Status Input: FY 2018 Qtr 1 Project  Reports Logout

Project Menu
Epxt ConTAcT: (NP83, 16-1, CAN LAND MANAGERS PREVENT THE "INEVITABLE COLLAPSE"OF BATS IN

THE WESTERN US?
List I Create

Contact T g
onta yee Financial Specialist w

First Name *: [anitz

Last Name *: [Hapzen

Position Title |Administrative Officer
Phone Number One: (775-234-7501 A HHH~HHHH

Phone Number Two: AKX XK IO

Email Address |3nita_hansen@nps.gov
[ orste | Delete

» To add a new contact, click the “Create” button.

T =

Logout

* 2 { Status Input: FY 2018 Qtr 1  Project  Reports

Project Menu
Epit ConTAacT: (NP83, 16-1, CAN LAND MANAGERS PREVENT THE "INEVITABLE COLLAF

THE WESTERN US?

List I Createl

Contact Type *:
e |Finan|:ia| Specialist i‘

There can be only one contact designated as the “Project Manager.” 1f a Project Manager has already
been assigned, the designation will not appear as an option in the drop-down menu when selecting the
Contact Type. You will have to “Delete” the existing Project Manager”. The other available choices for
Contact Type include Financial Specialist, SNAP, Other, and SNPLMA Program Manager.
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In the example below, Robert Taylor is entered as the Program Manager.

» Once you have finished entering the information for the new contact, click the “Save” button.
After doing so, a message will appear in green text confirming that the “Contact was saved
successfully.”

Project Menu
CreATE ConNTACT: (NP99, 16-4, RECONSTRUCT AND RESTORE THE HISTOR

CAMPGROUND
List I Create

Contact T e i
onta o= SNPLMA Program Manager | W

First Mame *: [Rohart |

Last Name *: [Taylor |

Position Title |nvement5 Program Manager |

Phone Number One: |?02_515_513g | KK HXH RN

Phone Number Two: | | KM RN

Email Address [r50taylo@blm.go X
| Cancel |

» To view the updated list of all contacts, click on the “List” button. This action will display the
revised list of contacts associated with your project, reflecting any new additions or changes
you have made.

e e T _ oy . i

+ 2 { Status Input: FY 2018 Qtr 1 Project Report Logout

Project Menu
SearcH ConTACT: (NP99, 16-4, REconsTRUCT AND RESTORE THE HistOoRIC WHEELER PEAK

CAMPGROUND

List Create

5 items found, displaying all items.

Position Title

+ Phone Number. Phone Number.
- 1 - 2 -

Financial Specialist Anita Hansen Administrative Officer 775-234-73501 anita_hansen@nps.gov Edit
Other Tod Williams Chier-Planning and Resources 775-234-7360 Edit
Other Curt Dimnirick Superintendent 775-2234-7302 curt_dimirick@nps.gov Edit
Project Manager Anita Hamsen Project Manager F73-234-7530 Anita_hansen@nps.gov Edit
SMPLMA Program Robert Taylor Capital Improvemeants Program 702-515-5129 rS0taylo@blm.gov Edit
Manager Manager
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STEP 5: ANNUAL ACCOMPLISHMENTS

Partners must enter annual accomplishments at two key points: first, during the first quarterly report of a
new fiscal year for the previous fiscal year, and second, at the project's closeout.

» To proceed with entering annual accomplishments, return to the Project Menu. Then, click on
“Enter Annual Accomplishments.”

ProJECT MENU: (P105, 12-57, FUEL TREATMENT EFFECTIVENESS SURVEYS, CALDOR FIRE

No Access For WorkPlan. Quarterly Status Update FY 2024 Annual Acenmnlishments

- Enter FY 2025 Annual Accomplishments. -
Closeout Inventory, ASAP Projects Only

Project Contacts

In the first quarter of the new fiscal year, you will need to describe the overall project accomplishments,
progress, and milestones achieved during the prior fiscal year. Double check with your Program Manager
on specific requirements and any information needs.

Please Note: The target audience for this report includes the public and Congress. This reporting is
distinct from the individual deliverable accomplishments reported to SNPLMA, as your Quarterly Status
Updates are the primary tool for monitoring those deliverables. The Annual Accomplishments you enter
here will be published on the SNPLMA website for public viewing and included in the SNPLMA Annual
Report to Congress.

For Project Closeout, you will need to summarize the overall project accomplishments from the
beginning through to completion. Lastly, if this is the final time you will be reporting and your project is
going to be closed, be sure to click the checkbox for “Final Overall Accomplishment.” This indicates
that you are providing the last report for the project, ensuring all relevant accomplishments are
documented properly.
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Please MNote: Your target audience for this report is the public and Congress. This is NOT for reporting to SNPLMA on your individual deliverable
accomplishments. Your Quarterly Status Updates are SNPLMA's tool for monitoring your accomplishments on deliverables. The Annual
Accomplishment input that you enter here will be placed on the SNPLMA website for public viewing and included in the SNPLMA Annual Report to
Congress.

Fiscal Year : |2|313

Annual Accomplishments :

um 3,000 characters.
Final Owerall I:‘
l—h““’“ — [ save | cance |

Daliverables

4 items found, displaying all items.

Deliverable # Description % Target Start Dat& Target End Datd
i IG0, Task Order, or Initial Funding Transfer 04/01/2016 06/20/2018
2 National Environmental Palicy Act Analysis (EA or EIS) 06/15/2016 06/15/2017
3 Other: Contracting and construction through full build-out, release of lien, and payment of all invoices,  08/15/2017 01/01/2020
4 Project Closeout 02/01/2020 06/01/2020

» Once you have completed entering your Annual Accomplishments, click the “Save” button.

STEP 6: Performance Measures

Performance Measure can now be entered separately and do not need to be included within your Annual
Accomplishments Narrative. This change provides a clearer distinction between general accomplishments
and specific performance metrics.

You will be entering each performance measure one at a time. You will find that the choices available for
selection are customized to your SNPLMA project category. This tailored approach ensures that the
performance measures align closely with the goals and objectives specific to your project.

» Once you select the “Performance Measures” button from the project menu screen. A new

screen will appear and click the “Add” button. under the Deliverable list on the Annual
Accomplishments page when you are ready to enter your Performance Measures.

ProJecT MENuU: (F194, 18-13, CHIMNEY BEACH PARKING UPGRADES FOR HIGHWAY 28 MuLti-USE
PATH

No Access For WorkPlan. Quarterly Status Update FY 2024 Annual Accomplishments
Enter FY 2025 Annual Accomplishments.
Closeout Inventory, ASAP Projects Only

T Goriars
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CrREATE/EpIT PROJIECT PERFORMANCE MEASURES

Performance Measures

Partner agencies and entities are expected to submit quantifiable data on project accomplishments as part of the project close-out request package.
Report all performance measures applicable to your project, even if the performance measure accomplished was not identified as a prlmary purpose
of the project and happened indirectly as a result of other project work. Please note that the entry of the Fiscal Year is no long d;
it will be automatically applied when the Project Status is updated to Closed (CL). Entries to be made by the agency/entity as follows 1.
Performance Measure: Select from the drop-down list of valid selections that are linked to the individual categories. 2. Quantity: Enter the quantity

to the nearest whole mile, acre, unit, etc. 3. Unit of Measure: Specify the unit of r corresponding to the quantity. 4. Comments: This is
optional entry for any additional notes or comments you may want to include.
Perf M :
erformance Measure : | | _ vl
Quantity : |
Unit of M :
it ob Teasure * | please select v |
Comments :

» The first drop-down menu you encounter will contain your list of valid performance measures.
These measures are specifically tailored to your program and reflect the metrics that are
relevant for assessing your project's outcomes.

» Do not enter duplicate PMs; instead, combine any relevant data into a single entry to avoid
confusion and ensure clarity in reporting.

CrREATE/ EDIT PROJECT PERFORMANCE MEASURES

Annual Accomplishments

Perf ™ E
erformance Measure : [y

Fiscal Year ; |C1 - Stabilized or Frotected # Cultural or Historic Sites or Structures

C2 - Protected # Culturzl or Palecntological Artifacts

Quantity : |C3 - Surveyed, Inventoried or Monitored # Acres of Cultural/Paleontological Resources

B HZ - Treated, Enhanced or Restored # Miles of Riparian Stream or Shoreline Habitat

Unit of Measure : H3 - Surveyad, Inventoried or Monitored # Miles of Riparian Stream or Shoreline Habitat

H4# - Treated, Enhanced, or Restored # Acres of Upland Habitat

H5 - Surveyed, Inventoried or Manitored # Acres of Upland Habitat

H& - Treated, Enhanced, or Restored # Acres of Wetland/Riparian Habitat

H7 - Surveyed, Inventoried or Monitored # Acres of Wetland/Riparian Habitat

HE - Constructed or Improved # Water Developments for Wildlife

H9 - Treated or Restored # Acres of Invasive Plant Species

H14 - Implemented # Threatened and Endangered Species Recovery Actions

H15 - Implementad # Conservation Actions for Mon-Listed Species

H1& - Decommissionad and/or Rehabilitated # Miles of Roads or Trails

01 - Remedizted # Hazardous Sites

02 - Constructed or Refurbished # Buildings, Facilities and/or Amenities

0% - Produced and Instzlled # MNew Interpretive or Education Publications/Signs/Kiosks/Displays
08 - Designed and Constructed # Buildings or Facilities that Support Green Sustainability

011 - Developed and Implemented # Datzbaszes, Reports, and/or Other Electronic Means of Documenting Activities
012 - Completed # Management Plans/Handbooks/Manuals/Guides for Activity on Public Lands
R.2 - Constructed or Improved # Recreational Facilities/Structures

F.4 -Constructed or Improved # Miles of Recreational Roads, Trails, or Routes

Commenits :

» After selecting the appropriate Performance Measure from the first drop-down, the next step is
to enter the “Quantity” associated with that performance measure in the designated box. This
quantity represents the numerical value related to the performance indicator you selected.

» Following this, you will encounter a second drop-down menu that contains your list of valid
“Units of Measure.” Here, you can select the unit that corresponds to the quantity you
entered.
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You may notice that there is no “Delete” button available for removing entries. If you make a mistake
while entering your Performance Measures, please contact your Program Manager to inform them of the
error. They will be able to assist you in addressing the issue.

It's important to note that this entry in SMART is designed solely for gathering data. The information you
provide will be exported to the SNPLMA Financial Database, where it can be utilized for reporting
purposes. Additionally, there is a report you should run once you enter your Performance Measures; be
sure to save this report to your files for your records

» Once you have finished entering your Performance Measure, click the “Save” button to record
your entry. After saving, if you need to enter another Performance Measure, click the “Add”
button to proceed with the next entry.

» If you wish to exit this screen and return to the previous menu, you can back out by clicking
on “Annual Accomplishments.” This will take you back to the Annual Accomplishments
page, allowing you to review your entries or perform other related tasks as needed. Make sure
to confirm that all information is accurate and saved before leaving the screen.

Step 7: ACCESSING REPORTS

You can run reports at any time, and it is not necessary for SMART to be open while generating them.
Additionally, you have the ability to run reports on all of your projects, not just the currently active ones.
This flexibility allows you to gather comprehensive data and insights across your entire project portfolio,
making it easier to track progress, manage funding, and evaluate performance.

» To access the Report menu, click on “Reports” from any page within the application. Reports
will open in a new window, ensuring that closing the report does not close SMART.

SNPLMA Management And Reporting Tool ,-I___u_,._\
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At the top of the screen, you will find new instructions designed to assist you in navigating the
application. Additionally, I will outline some of the quirks of using this new application to enhance your
experience.

Home > SNPLMA - SMART: Eniity Reports

SMART - Entity

Instructions for running reports:

To run a report you will:

1. Select the report that you wish to run

2_You will then go to a "dashboard" designed specifically for that report and here you will make your more specific selections of: Program Category, Managing Entity, etc.
3. The default is "All"

4. Uncheck or check as needed, be sure to click outside of the box you make your selections from to lock down yeur choice(s)

5. Once all of your choices are made you will click on the "Apply” button

Work Plan Annual Accomplishment Financial Summary Contact List
Report Reports Reports Entity Contact
Project Werk Plan(s) Accomplishments ASAP Detail (Entity)
Final Overall Accomplishments Direct Charge Detail (Entity) closeﬂut
Performance Measurement Report Reimbursement Detail |rlvel1tory
Transfer Detail Closeout Inventory
Percent Transferred Funds Expended/Obligated Status Update Report
Percent Transferred Funds Expended/Obligated Status Update(s)

Individual Project Quarterly Status

Individual Project Quarterly Status

Work Plan & Status Update Report

Work Plan Status Update

» The first step is to select your report. When you select a report, it will open in a new tab.
For example, you will see the “Dashboard” for the Project Work Plan(s) Report displayed.

» Please note that the default parameters are set to “All.” It is crucial to customize your parameter
selection before running any reports. Attempting to run a report with the default “All” setting may
cause issues or result in overwhelming amounts of data that can be difficult to manage.

» Additionally, on the dashboard, you can see your login name displayed. This feature helps confirm
that you are operating within your account and can assist in maintaining secure access througout
your session. Be sure to check that your parameters are correctly set before proceeding with any
report generation to ensure accurate and relevant results.

I -|EF https:// reports.test blm.gov/xmlpserver/SMPLIMA+ - - SMART/BIP+ Reports/SHPLMA+ £ ~ @& C | {2 SMART - SNPLMA Manageme... & BLM Reporting Application F SNPLMA Project Work Plan... %
file  Edit View Favorites Tools Help

15 @] Hyperion 2017 & OBIEE - Test ] OBIEE - Prod 2] Acquisitions Shared Docu... & Google Ff SNPLMA (B BMC Remedy Mid Tier 8.1... <G Custorner Login - Replico.. FE Degrees Minutes Seconds ... £ SMART &)

CORACLE" BlPublisher Enterprise

SNPLMA Project Work Plans t
Program Category | All A
Managing Entity § All v
Round § All -
Project Number | All | DACKERMAN Apply
Project Work Plans
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The drop-down menus for selecting parameters will only display the options that you are authorized to
view. This means that you will only see projects and data relevant to your permissions, ensuring that you
can only access information you are authorized to see.

» Please remember to uncheck the “All” option before running your report. It is advisable to
select only the specific project for which you need information. This targeted approach helps
ensure that the report generated contains only relevant data, making it easier to analyze and

interpret.

sk &) Hyperion 2017 &) OBIEE - Test £ OBIEE - Prod & Acquisitions Shared Docu... & Google F SNPLMA El

ORACLE" BlPublisher Enterprise
SNPLMA Project Work Plans
Program Category All

Managing Entity WAl

Capital Improvements
Round i Cap P

] Conservation Initiatives
Project Number

Project Work Plans

] Eastemn Nevada Landscape Restoration Project
] Hazardous Fuels Reduction Plans and Wildfire Prevention Projects

] Pre-Propesal Planning (PPP)

Search ...

F12

o & TIypenon 2017 B GOIEE - TE -

ro

cqu SIEIDFIS gF'

ORACLE’

SNPLMA Project Work Plans
Program Category Al
Managing Entity All

Round

Project Number

Gen 2 | Hyperion 21T 2] QBIEE - Test 2| ORIEE - Prod 2] Acquisitions

Bl Publisher Enterprise

I Al

W] USDA Forest Service

v

Search _.. F12

=TT R TR =R

M RALC L E" Bl Publisher Enterprise

SHNPLMA Project Work Plans
Program Category &A1 -
Managing Entity AR -

Round AR -

Al -
Al

Froject Number

Paajiscl Work Plans W] FOO0

| Foaz
¥ Foos
W] FOO4

~| FDas et

F12

Search .
__
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Making your selections in the reporting interface can be a bit tricky at times.

Once you make your initial selection, such as choosing ENLRP, be sure to “click” anywhere on the
screen to lock in that choice. This step is important, as it confirms your selection and allows the system to
register it properly.

Please note that you should avoid clicking on the “Apply” button at this stage, as doing so will
immediately run the report based on your current selections. Instead, ensure your choice is locked in by
clicking away, allowing you to make any further adjustments to your parameters or selections before
finalizing and running the report. This process helps prevent any mistakes and ensures that you have
everything set up correctly before generating your report.

I @ SMART - SNPLMA Management X | W BLM Reporting Application X  §F SMPLMA Project Work Plans -0 X =+

“ = C O @ reports.blm.gov/xmipserver/SNPLMA+-+5MART/BIP +Reports/SNPLMA+Project+Work+Plans.xdo?_xp

I Apps b Bookmarks 43 Find all queries that.. §F BLM National Help... %, My Account | Thrift.. @ Home-SNPLMADi.. |

Program Category Eastemn Mevada Landscape F w

! Managing Entity A

Round U Capital Improvements

Cc tion Initiati
Project Number [0 Conservation Initiatives Apply

Eastern Nevada Landscape Restoration Project

Project Work Plans ) - -
[ Environmentally Sensitive Land Acquisitions

(0 Hazardous Fuels Reduction Plans and Wildfire Prevention Projects

Search ... F12

After making a selection from the dropdown menus, be sure to “click” somewhere on your desktop or
another area outside the dropdown to lock in your choice. Do not click on “Apply” yet. Repeat this
process for all of your selections, ensuring that each choice is confirmed before proceeding.

Once you have made all of your selections and are satisfied with them, you can then click on “Apply.”

Upon clicking “Apply,” you will see a confirmation or loading message, indicating that the report is being
generated based on your selected parameters. This transition confirms that the system is processing your
request. From there, you can review the report that is generated, ensuring it meets your needs and contains
the relevant information for your project.

Project Work Plans & =B &0

15 | - v+ @D

SNPLMA Project Work Plan

Bureau of Land Management

Eastern Nevada Landscape Restoration Project
17-1: Atlanta Road Sage-Grouse Habitat Improvement Completion Project(B016)
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You can scroll through all the pages of the report you just generated. However, you will likely want to
print and/or save the report for your records or future reference.

On the right side of the report, you will see options or icons that allow you to perform these actions easily.

“ = A &+ O

Clicking on the PDF Icon at the very top will allow you to select the document format you wish to use for
your report.

Typically, you may have options such as PDF, Excel, or Word formats, depending on what the

application supports. Selecting your preferred format will enable you to download or generate the report
in that specific type.

3 :

i
[
4

o 7

[@] HTML

[ POF

[Z] RTF

[¥] Excel (*.xlsx)

[F] PowerPoint {*pptx)

Using options from this menu will only change how the report is displayed on your screen and will not
affect the underlying data or report itself.

It is recommended that you avoid modifying these display settings, as they might not provide any added
value or clarity to your report. Instead, focusing on saving or printing the report in its current format will

likely be more beneficial

It is recommended that you click on the download or printer icon to proceed with saving or printing the
report. These options will allow you to export the report in a format that best meets your needs.

By clicking the download icon, you can save the report to your device in a desired format, such as PDF or
Excel, making it easy to access later or share with others.
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If you are viewing the PDF as shown above, you can click on the “download” symbol ! to save the
PDF file to your device. This action allows you to store the report in a location of your choice for easy
access and reference in the future.

E Save As x
4 3 ThisPC » Local Disk{C:) » BLM Work » March 2021 v [J] 2 Search March 2021
Organize * Mew folder Bz - o
~
¥ Downloads # *  Name Date modified Type Size
% Documents
No items match your search.
=1 Pictures »
April 2021
Financial Trackin
Secretary Decisic
USER GUIDE
I Desktop
4 Ackerman, Debc
= ThisPC
‘+ Libraries
w¥ Network
Misc \
File name: ~
Save as type: | HTML Document (*.htm) ~
. Hide Folders sve | | Cancel

If you want to physically print the report, click on the printer icon EI . This will open the more familiar
Print Dialog Box where you can adjust your printing preferences.

In the Print Dialog Box, you can select your desired printer, choose the number of copies, and adjust other
settings such as page orientation and paper size. Once you have configured these settings to your
satisfaction, click the “Print” button to send the report to your printer.

SUMMARY

The first step in the process should be completed for all new projects. For each project that is not marked
as either closed or terminated, you should repeat steps two through six.

e Ifyou encounter any problems, issues, and errors, please report them by email to the System
Administrator, Tara Beck at tbeck@blm.gov. If the issue cannot be resolved by the System
Administrator, a remedy ticket will be submitted to the Network Operations Center (NOC) for
further assistance.

e As always, for assistance with any SNPLMA questions or reporting requirements, you may reach
out to your Program Manager. They are available to help you navigate any concerns or inquires
related to your projects.
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